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1. Introduction

The traditional approach to redesigning a chart of accounts (COA) is to convene a discussion among
accountants to agree upon the data elements needed for financial accounting and reporting. These
discussions yield decisions on how transactions are to be coded in the accounting system (i.e., the
mandatory coding block) and what information would be reported out of the system. In the traditional
approach, deliberations are informed by external guidance, such as Generally Accepted Accounting
Principles (GAAP) as defined by the Governmental Accounting Standards Board (GASB), and internal
guidance, such as statutorily defined financial control and reporting requirements.

The state of Washington (Washington), in preparation for the implementation of its next-generation
enterprise resource planning (ERP) system, has chosen to go beyond the traditional approach to
redesigning its COA. It has taken a much more forward-thinking approach to COA design that
accomplishes all the objectives of a “traditional” COA redesign while also addressing important
strategic considerations.

Washington’s COA redesign seeks to establish a strong and direct linkage between the manner in
which financial data is defined and collected (in the COA) and:

e  Washington's information management strategy (the data and analyses that are reported) and

e  Washington's operating principles for service delivery (the results that are delivered).
(See the Appendix A for a list of these operating principles.)

Redesigning Washington’s chart of accounts is one of the most strategically important actions the state
will take in preparing the ground for its new ERP system. The redesigned COA is based on leading
practices in government and business. In addition, the new chart has been designed in advance of
selecting the state’s ERP solution to help ensure that it, first and foremost, serves Washington’s
strategic purposes. The redesigned COA is “software agnostic” and not shaped by the technical
requirements of any vendor’s software product.

2. Chart of Accounts Redesign Objectives and Approach

Objectives
The redesigned COA is intended to:

e Reinforce Washington’s Transformation Strategy by using the redesigned COA to help redefine the
manner in which state operations are managed and services are delivered to citizens;

® Support Advance Planning for Washington’s New ERP System by developing a forward-looking
design that emphasizes simplicity, expandability and flexibility for the life of the system;

e Facilitate Adoption of an Enterprise-Wide COA by meeting the needs of both the state’s central
control and line operating agencies.

Approach
The approach used to develop the new COA design for Washington included eight sequential activities
completed from January through May 2016. These activities are summarized below.

1) Survey Key State Agencies and Conduct Follow-Up Interviews — The survey captured information
about the state’s current COA and its actual use by agencies. It included questions about “pain
points” for agencies regarding the existing COA. The follow-up interviews gathered additional
insights about agencies’ pain points, as well as about features and functions they would like to see
in the redesigned COA.

2) Conduct Information Strategy Lab — The objectives of the Information Strategy Lab were to:

a) Identify “burning questions” related to the state’s finance processes for which managers need
information, and
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3)

4)

5)

6)

7

8)

b) Use these questions to help determine key data elements to be included in the redesigned COA.
The Lab also featured discussions about future COA governance and maintenance of data integrity.

Conduct Workshop to Review Draft COA Taxonomy — Workshop #1 brought together Finance,
Budget and Operations managers from selected agencies representing a variety of reporting and
control needs. The workshop focused on leading COA design practices and trends in other states.
Participants reviewed a set of data taxonomies proposed for the redesigned COA, comparing them
to the current COA’s structural elements. They also discussed key COA features required to take
full advantage of a modern ERP system.

Develop and Socialize “Strawman” COA Design — Following Workshop #1, a mock-up of the
redesigned COA was developed for review and comment by key stakeholders. This “Strawman”
provided a check-point midway through the project to allow stakeholders to confirm that the new
design would address identified issues and future needs as expected and to offer amendments to the
design where needed.

Conduct Workshop to Review Strawman COA Design — Workshop #2 provided a forum in which
the Strawman’s reviewers discussed details of the proposed COA design and shared their
comments and recommendations for improving it.

Incorporate Feedback from ERP Software Vendors on Strawman COA Design — Following
Workshop #2, stakeholder suggestions were incorporated and the revised Strawman was sent to
selected ERP software vendors with a request for feedback on the proposed COA design and its
compatibility with their products. Vendor comments were reviewed by the project’s Executive
Steering Committee and, as appropriate, incorporated into the Final COA Design. (See Appendix B
for a summary of vendor feedback.)

Develop and Socialize COA Governance Model and Maintenance Process — A new COA
governance model and maintenance process were developed and reviewed by the Executive
Steering Committee. In vetting the proposed governance approach, the committee focused on the
need to ensure consistent use of the chart in the future while allowing enough flexibility to
accommodate special agency requirements.

Develop Final COA Design — The Final COA Design (this report) presents the refined COA
structural elements and governance approach proposed for the state.
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3. Leading Practices and Design Principles Underlying the Redesigned Chart of Accounts
When designing a COA, it is important to meet the information and reporting requirements of all key
stakeholders. A statewide COA must address the needs of a variety of agency users and their various
data requirements. The definition, use and maintenance of the COA are essential to ensuring data
integrity and practical use of reports generated by the finance and accounting system.

As part of the process of designing its new COA, the state of Washington reviewed leading practices
that have played an integral part in the successful design and maintenance of COAs in other states and
organizations. These practices and the benefits they provide for organizations whose COAs incorporate

them include:

Adopt a Single,
Global COA

Maintain a Lean
COA

Eliminate Miscellaneous
Coding Elements

Provide for “Optional”
Agency Coding
Elements

Build Flexibility into the
COA Coding Scheme

Centralize Management
of the COA

Institute a Formal COA
Governance Structure

Use ERP Sub-Systems
for Transaction Details

Standardizes COA coding element usage and provides consistent application
across state government.

Ensures consistent data definitions and roll-up structures.

Ensures consistent data capture and simplifies data retrieval processes for
reporting and analysis.

Defines data elements at the lowest level required to make business decisions.
Creates consistency and ensures compatibility of reported information across
state agencies.

Reduces the need for data reconciliation and reclassifications.

Reduces the opportunity for inconsistent use of chart elements.
Promotes a statewide perspective when recording and reporting financial
information.

Provides agencies the option to request coding elements that decompose the
sub segments above them in the data hierarchy.

Creates new coding elements that are available to all agencies, given that each
is used consistently statewide.

Provides room for growth and flexibility for changes in the organization over
time without having to alter the COA structure.
Translates transaction-level details into higher-level summary information.

Incentivizes agencies to comply with statewide COA data definitions.
Ensures agencies use coding elements already established for a special
function or purpose instead of creating new ones.

Ensures the COA will remain relevant and useful despite changes to
government spending and revenue requirements over time.

Balances the need to allow appropriate COA evolution with the need to
support ongoing longitudinal data analysis.

Allows transaction details to be “pushed down” into sub-ledgers (e.g. accounts
payable, accounts receivable, fixed assets, treasury management, projects,
grants, budget preparation, travel and expense, etc.) where the data can be
easily retrieved or referenced from the general ledger.

Ensures the core financial system is the system of record and primary source of
financial information.

The state has endeavored to apply all of these practices to its new COA design.
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4. Legacy Chart of Accounts Overview

The State of Washington’s Uniform Chart of Accounts (Legacy COA) is detailed in Chapter 75 of the
Statewide Administrative & Accounting Manual issued by the Office of Financial Management (OFM).
(For full details, go to http://www.ofm.wa.gov/policy/75.htm.) The Legacy COA provides the coding
scheme for all transactions recorded in the state’s Agency Financial Reporting System (AFRS).

Structural Elements
The state’s legacy COA is comprised of 11 structural elements (or segments) through which
transactions entered into the AFRS general ledger are organized, as shown below.

Washington Uniform Chart of Accounts Structural Elements

General
Ledger
Account

Subsidiary § Revenue

Program
Account Source g

The Structural Elements’ purposes are summarized in the following table.

Structural

Element Primary Purpose(s)

Agency Used to identify state agencies.

Organization Used to identify or accumulate costs by cost center.

Fund Used to identify the accounting entity against which a transaction is to be charged.
Qert = Used to identify each legislative or executive spending authorization.

Appropriation

= Codes are assigned for each agency each biennium by OFM.

= Used to classify in summary form all transactions of an accounting entity.
= Agencies may change GL account codes for internal purposes but must convert back to
the authorized statewide codes before submitting information to AFRS.

General Ledger
Account

Subsidiary General = Used to code the associated entity for any inter-agency or inter-fund transaction.
Ledger Account = Also used to record the agency on the other side of the transaction.

Revenue Source Used to identify the original category from which revenue is derived.

Expenditure Object Used to classify expenditures.

= Used to identify agencies’ major activities expressed as primary functions or
Program organizational units.
= Codes generally are assigned by agencies with the concurrence of OFM.

= Used at the statewide level to capture expenditure data on information technology (IT)
acquisitions and new development and on IT maintenance and operations.

EERIESE = Used by some agencies to capture transactional data on agency-specific projects.
= Can be used over multiple years and biennia to accumulate transactions over time.
Other Used by state agencies to code items such as county/city/town locations, budget

allocations, budget units, months of service, etc.
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For AFRS journal entries, the structural elements required of most agencies for transaction coding are:

General Ledger Agency*Fund*GL Account*Subsidiary Account

(Balance Sheet)
Revenue Agency*Fund*GL Account*Revenue Source
Expense Agency*Fund*GL Account* Appropriation*Program*Expenditure Object

Coding Elements

Coding elements are defined parts of the accounting code that identify increasingly detailed sub-
components of a structural element. The Legacy COA’s structural elements are segmented into coding
elements (or sub-segments), as follows:

= Agency 3 Numeric Centrally
Agency = Sub-Agency 1 Alpha
= Division 2 Alphanumeric Agency
= Branch 2 Alphanumeric Agency
Organization = Section 2 Alphanumeric Agency
= Unit 2 Alphanumeric Agency
= Cost Center 2 Alphanumeric Agency
= Accounting Fund 3 Alphanumeric Centrally
Fund = Fund Detail 0 (Not Used)
= Appropriation 3 Alphanumeric Centrally
Appropriation = Appropriation Type 1 Alphanumeric Centrally
= Appropriation Character 1 Numeric Centrally
General Ledger = General Ledger 4 Numeric Centrally
Account = Memorandum 4 Numeric Centrally
Subsidiary General = Subsidiary Account 6 Alphanumeric Agency
Ledger Account (BOth Debit and Credit)
=  Major Group 2 Numeric Centrally
Revenue Source =  Major Source 2 Numeric Centrally
= Sub-Source 6 Numeric Agency
= Object code 1 Alpha Centrally
Expenditure Object = Sub-Object 1 Alpha Centrally
= Sub-Sub-Object 4 Numeric Agency
= Function 2 Numeric Centrally
= Program 3 Alphanumeric Centrally
Program = Sub-Program 2 Alphanumeric Agency
= Activity 2 Alphanumeric Agency
= Sub-Activity 2 Alphanumeric Agency
= Task 2 Alphanumeric Agency
= Project Type 1 Numeric Centrally
Project = Project . 4 Alphanumer%c Agency
= Sub-Project 2 Alphanumeric Agency
= Phase 2 Alphanumeric Agency
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Character Centrally or

Structural Element Coding Elements Length Code Type |Agency Defined?

= County 3 Numeric Centrally

= Cities/Towns 4 Numeric Centrally
Other = Budget Allocation 4 Alphanumeric Agency

= Budget Unit 3 Alphanumeric Agency

=  Month of Service 4 Numeric Agency

= Work Class 3 Alphanumeric Agency

Coding elements are defined either centrally by OFM for uniform statewide use or by individual
agencies for their own internal purposes. Centrally defined coding elements are required for preparation
of the Comprehensive Annual Financial Report (CAFR) and other statutory reporting. All agencies must
use centrally defined coding elements in the same way without exception. Agency-defined coding
elements are not required for statewide reporting. They provide more granular levels of detail for
agencies’ internal reporting. Agency-defined coding elements are created and maintained by each
agency at its discretion.
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5. Redesigned Chart of Accounts Structure

Chart of Accounts Taxonomies and Financial Data “Roll-Ups”
COA taxonomies are hierarchical classifications of required information that:

® Meet legal and administrative requirements for budget management and financial reporting.
¢ Conform to certain (e.g., industry) standards on financial and statistical reporting.

® Meet enterprise requirements for planning, controlling and reporting.
Each taxonomy is a data hierarchy that can be decomposed to as many levels as needed.

A modern COA’s classification scheme includes taxonomies that cover discrete information
requirements for enterprise management, reporting and control purposes. For state government, an
adequate COA classification scheme should include the taxonomies shown in the following diagram.

State Government Model COA Taxonomies

Organization Fund Expenditure Balance Program
& Type Authority Sheet 8

Defmes Defines Defines Defines Defines Defines services Defines projects Defines physical Defines
org gover legal levels of assets, liabilities, sources and delivered to and grants and locations non-financial
entities proprietary, and appropriation and net position uses of funds citizens and their phases, statistical
fiduciary funds stakeholders tasks, and information
sub-tasks
Traditional COA Taxonomies

Each taxonomy is a data hierarchy that can be “rolled up” from as low a level of transactional detail as
needed to a comprehensive summary level. Each sub-segment of the hierarchy decomposes the one
above it in a uniform, logical progression. For example, as shown in the diagram below, for the fund
type taxonomy, the data hierarchy could start with the segment “fund type” (parent level) and descend
one or more sub-segments (child levels) below that.

Example of a COA Taxonomy Hierarchical Data Structure “Roll-Up”

e

SEGMENT (Parent Level)

SUB-SEGMENT (Child Level 1)

Governmental
Funds

Proprietary
Funds

Fiduciary
Funds

SUB-SEGMENT (Child Level 2)

Debt Service Permanent
Funds Funds

Capital Projects
Funds

General Special Revenue
Fund Funds

v y v v

SUB-SEGMENT (Child Level 3) State Higher Education
Facilities Fund Facilities Fund

As shown, each sub-segment of the hierarchy is a decomposition of the segment or sub-segment
immediately above it. In the hypothetical example shown above:

— “Fund Type” is decomposed into sub-segments for governmental, fiduciary, and proprietary Funds;

b “Governmental Funds” is decomposed into sub-segments for general fund, special revenue
funds, capital project funds, and debt service funds;

L “Capital Projects Funds” is decomposed into sub-segments for general capital projects
fund, transportation capital projects fund, and environmental capital projects fund.
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For reporting on activity within a discrete taxonomy, the COA coding elements that correspond to the
taxonomy’s segments and sub-segments organize and group financial information so that it is
consistently recorded and can be “rolled up” to whichever level of the data hierarchy is required for
different financial and management reports. For reporting on activity across taxonomies, relationships
among COA coding elements can be configured using the relational data base functionality of a
modern ERP system so that the elements within any taxonomy at any level of its data hierarchy can be
related to elements within any other taxonomy at any level of its data hierarchy.

An example of how reporting across taxonomies works would be a road construction project with
components funded from both a capital projects fund and a special revenue fund and involving
expenditures by several agencies (e.g., DOT, DOE, OFM, etc.). A modern COA classification scheme
coupled with ERP relational database functionality would enable reporting of total project costs regardless
of funding source or organizational unit, as well as reporting of project costs by fund or agency.

Chart of Accounts Management and Discipline

Every sub-segment of a modern COA should have a uniform definition across the enterprise. This does
not mean that sub-segments defined to meet the special requirements of one or more sub-units of the
enterprise are excluded. Such specially defined sub-segments can and should be included in a COA.
However, once defined and included, such sub-segments must be used in the same way by all sub-units
of the enterprise, and duplicates of such sub-segments should not be added to the chart going forward.

What this means in practice is that, within each COA taxonomy, high-level sub-segments should be
defined and established by a central authority for the entire enterprise, while low-level sub-segments
may be proposed by sub-units when needed subject to formal approval by the central authority. As
illustrated in the diagram below, the level at which sub-segments would be defined for all centrally or
proposed by sub-units will vary by COA taxonomy.

Example of Variation of Sub-Segment Origination for COA Taxonomies

S Expenditure

Sub-Segment 1

(ol-1,1 (/)2 Sub-Segment 2
Defined

r
Sub-Segment 3 | |
| |

Sub-Segment 4

|

Agency- b e e —— 1
Jielolo-L/8  Sub-Segment 5

Centrally-
Approved

Within each COA taxonomy, all agencies will be required to use centrally defined coding elements
corresponding to the taxonomy’s segments and sub-segments down to a specified level of the data
hierarchy. Below this level, if they desire it, agencies will have the option of requesting coding
elements that decompose the sub-segments above them in the data hierarchy. However, whenever an
agency defined coding element is established for one agency, the new element’s definition will apply
for all agencies, and the element should be used consistently by all agencies. Once established, no
coding element, whether centrally defined or agency defined, should ever have more than one
definition or transactional use.
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Chart of Accounts Structural Elements Underlying Key Financial and Management Reports

State agency financial and management reporting requires use of the COA to extract specific data
needed for any given report. The COA’s structural elements provide the framework to organize such
information for reporting purposes.

Agency managers rely mainly on four types of report for financial control and planning purposes,
including:

= Appropriation Monitoring Report » DSHS
= Cash Flow » DOH
Budgetary/ = Contracts Payable » DOH
Spend Control " GHS Monthly Charts > DSHS
» Liquidations Report » DSHS
= Monthly Fiscal Status Report for Programs > DSHS
= QOvertime Report Summary » DSHS
Cost Analysis/ " Cost Allocation JV Verification » DOH
Spend Decision " Cost Allocation - Recovery by Division » DOH
= Expenditure Grouped by Object » DOH
Management = Annual Bond Sale-Six Month Bond Sale Information > DOT
Planning = January 2016 OFM Allotment Report-Q2 Operating Budget > DOT
= Private Local Revenues and Expenditures by SSCRO »> DSHS
= 1Q Financial Report through September 2015 > DOT
. = CAFR-Fund Balance Sheet > OFM.Statewid
Public = CAFR-Statement of Activities atewice
Accountability « CAFR-Statement of Net Position > QRiRsEEm
= CAFR-Statement of Revenues, Expenditures, Changes in > QRiRsEEm
’ ’ » OFM-Statewide

Fund Balance

To generate such reports, AFRS draws required data that is entered into the system using specific COA
structural elements. Each of these legacy COA structural elements corresponds to one of the model
COA taxonomies, as shown in the table below.

= Agency » Organization
= Expenditure Authority » Expenditure Authority
* Fund » Fund
Budgetary/ = Geperal Ledger. Account » Account
Spend Control " Object/Sub-Object » Account
= Organization » Organization
= Program/Sub-Program »> Program
* Project » Project
= Other » Geo/Location
= Expenditure Authority > Expenditure Authority
* Fund » Fund
Cost Analysis/  « Qbject/Sub-Object > Account
Spend Decision Program/Sub-Program »> Program
* Project » Project
= Revenue/Major/Source » Account
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Report Type | Legacy COA Structural Elements Corresponding COA Taxonomies

= Agency » Organization

= Expenditure Authority » Expenditure Authority
Management = Fund » Fund
Planning = Object/Sub-Object > Account

= Program/Sub-Program » Program

= Revenue/Major/Source » Account

= Agency » Organization

= Expenditure Authority » Expenditure Authority
Public = Fund » Fund
Accountability " General Ledger Account » Account

= Object/Sub-Object » Account

= Program/Sub-Program » Program

= Revenue/Major/Source » Account

The model COA taxonomies cover all legacy COA structural elements on which essential agency
reporting through AFRS currently relies. The model COA taxonomies corresponding to the legacy
elements will provide the organizing scheme for Washington’s redesigned COA and ensure all data
required for agency reporting purposes will be captured in the state’s new ERP system.

Structural Elements for the Redesigned Chart of Accounts
Eight structural elements are proposed for Washington’s redesigned COA, as shown below.

Chart of Accounts Structural Elements

PROPOSED COA STRUCTURAL ELEMENTS

o Expenditure Geography/
— ' - - ' ' -

The legacy COA’s structural elements are subsumed by the proposed structural elements as illustrated
in the following diagram.

Cross-Walk Between Redesigned and Legacy Structural Elements

PROPOSED COA STRUCTURAL ELEMENTS
GL
Acct.

SUBSUMED LEGACY COA STRUCTURAL ELEMENTS

Expenditure
Authority

Geography/
Location

Program

1
1
1
1
1
1
1
1
|
|
|
|
Source Object I | :
1

10
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The proposed structural elements’ purposes and their key differences from similar elements in the
legacy COA are summarized in the following table.

Organization = Used to collect organizations of people = Aligns with three branches of
common to an administrative function. government at statewide level.
Used to identify the accounting entity against ~ Reduces coding elements to just GAAP-
Fund which a transaction is to be charged. defined fund types.
= Used to capture appropriations and other Restructures coding elements to roll up
Expenditure expenditure authorizations. to budgeted and non-budgeted
Authority = Required for coding to expense accounts. expenditure authorizations.
Used to capture all transactions that affect the = Combines general ledger account,
balance sheet, operating statements, and other revenue source, expenditure object,
financial statements. and their subordinate coding elements.
Account = Facilitates use of roll-ups to develop
CAFR and other management reports.
= Inter-organization detail maintained
under this structural element.
= Used to track revenues and expenses = Creates new service types to be used
. related to service programs. uniformly by all agencies.
Service » Used to report on government functions » Ends use of program for
across organizations and projects. miscellaneous coding purposes.
= Used for both projects and grants for cost = Establishes new scheme available to
tracking and analysis. all agencies for project data entry.
. = Hierarchically relates as many projects/ = Can interface with agency project
Project . .
sub-projects and/or phases as needed. management charts at high or low
= Defined for a specific purpose that can levels of detail, as required.
span multiple fiscal years.
= Used to track revenues and expenses = Creates new service types to be used
. related to service programs. uniformly by all agencies.
Service = Used to report on government functions * Ends use of program for
across organizations and projects. miscellaneous coding purposes.
Used to track revenues and expenses specific = Establishes new element to be used
Geography/ to a location or geographic center. uniformly by all agencies.
Location = Discontinues use of other legacy
element for location coding.
Used to track non-financial measures, such as  Establishes new element to be used
statistical information, metrics for service uniformly by all agencies.
Outcome

= Used to capture the departments and
organizations of an agency.

outcomes, service-recipient headcounts, etc.

= Combines agency and organization
legacy elements.

11
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The proposed COA structural elements incorporate leading COA design practices, such as a global,
lean COA that excludes the use of miscellaneous elements. The following table summarizes significant
benefits expected to result from adoption of the proposed elements for Washington’s redesigned COA.

Organization

Fund

Expenditure
Authority

Account

Service

Project

Location

Outcome

Simplifies journal coding by combining agency and organization into one element.
Aligns departmental units within agencies more closely.

Simplifies and aligns fund coding with GAAP.

Eliminates the need for some appropriation codes through use of hierarchical reporting
roll-ups.

Allows users to retrieve accounting data that pertains to balance sheets, fund balance,
revenue reporting, and expenditure analysis through one COA element.

Takes advantage of reporting roll-ups to develop the CAFR and other statewide
management reports.

Tracks transactions for revenues and expenses across or within programs.
Enables statewide reporting on common functions and services across agencies.

Enables tracking of project or grant revenues and expenses in the general ledger.
Enables use of projects and grants sub-systems in modern ERP systems to maintain
deep levels of detail.

Enables budget vs. actual analyses for projects and grants.

Records “individual tasks” or “parts of the whole” that make up projects and grants.

Enables financial and outcomes measurement across geographic locations.
Eliminates the need for location-specific code values embedded in legacy
organization, program, sub-source, and sub-sub-object elements.

Relates financial information and outcome measurements to inform agencies and the
public on the effectiveness of financial spending and investments.

Coding Elements for the Redesigned Chart of Accounts

The structural elements/segments proposed for Washington’s redesigned COA are decomposed into
coding elements/sub-segments that provide progressively more granular levels of detail for coding
transactions. The proposed coding elements for the redesigned COA are presented in the following table.

Sub-Segment 1
Sub-Segment 2
Sub-Segment 3

Sub-Segment 4+

Sub-Agency

Chart of Accounts Coding Elements

Branch Fund Appropriation Account  Service Project County Priorit
Type Authority  Level 1 Type Type Group y
. . Spending  Account . . Initiative
Function Suite Aty | el 2 Suite Suite County Grom
Spending  Account . . o
Agency Fund Source Level 3 Service Project Sub-County 1 Initiative
Sub- Budget Account

Fund Control Level 4 Sub-Service Sub-Project Sub-County 2 Sub-Initiative

12
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Under any structural element, each sub-segment is a decomposition of the one immediately above it. The
decomposition comprises a set of components that are mutually exclusive and collectively exhaustive
(MECE). For example, sub-segment 1 under “Organization” — “Branch” — includes the executive,
legislative and judicial branches of Washington state government. These sub-segment components are
mutually exclusive (none overlaps with any other) and collectively exhaustive (all the branches of state
government are included). Each subsequent sub-segment is designed to be similarly MECE.

For each structural element, the level of detail (i.e., the deepest sub-segment) at which agencies should
be required to code transactions will depend on Washington’s specific business needs for statewide
financial management and analysis. For example, under “Account”, to provide sufficient detail
regarding revenues and expenses statewide agencies should be required to code transactions at the
lowest level. By contrast, under “Project”, assuming statewide financial management does not involve
going into the details of agency projects, agencies may be required to code transactions only at sub-
segment 2. If an agency desires transaction details for its projects by “Phase”, “Task’ or further levels
of decomposition, it could code transactions at its level of choice below the required level.

Modern ERP systems include tools to assist end-users with transaction coding (e.g., inference tables
and speed charts) that eliminate the need for users to memorize numerous, lengthy transactions codes.
These tools take advantage of the hierarchical structure of a modern COA and automatically populate
required summary level codes when a transaction is coded at the lowest level. These tools help avoid
overwhelming end-users with too many coding requirements and greatly reduce coding errors.

Diagrams showing the decomposition of each proposed structural element/segment into its subordinate
coding elements are presented below. The diagrams show how each structural element is decomposed
by sub-segment, but they do not specify all components for each sub-segment. In addition, for each
structural element the diagrams indicate the deepest sub-segment at which transaction coding should
be mandatory for all agencies and those below it at which coding would be optional.

The following structural element decompositions are a proposed framework for Washington’s
redesigned COA, not a complete chart. The complete chart’s detailed coding elements/sub-segments
will be developed through future discussions and agreement on statewide element definitions and data
hierarchies between OFM and key state agencies.
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Organization Coding Elements

The structural element “Organization” is decomposed at the highest level into coding elements for the three branches of state government. In
turn, each “Branch” is decomposed into “Functions” derived from functional groups specified in Section 75.20.30 of SAAM Chapter 75.
Each “Function” is decomposed into its constituent state agencies also specified in Section 75.20.30. Each “Agency” can be decomposed
into common “Sub-Agency” units (e.g., department, division, office, etc.) or into common functions (e.g., Finance, HR, IT, etc.).

rPR_OILO§|ED COA STRUCTURAL ELEMENTS

Expenditure

Authority

Geography/
Location

SEGMENT (Parent Level)

ORGANIZATION

SUB-SEGMENT (Branch Level 1)

SUB-SEGMENT (Function Level 2)

v

General Natural

Other
Functions

Human
Services

Resources and @ Transportation
Recreation

Government
Operations

Seaptena e T P P

OFM DOR Etc.

SUB-SEGMENT (SubtAgency Level 4+)

Standard Org Sub-Components for All Agencies

Example: Executive, Finance, HR, IT, Operations, etc.

Legislative
Operations

r

Judicial
Operations

P

Mandatory
Coding

Optional
Coding
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Fund Coding Elements

The structural element “Fund” is decomposed at the highest level into coding elements for the three GAAP-defined government “Fund Types”.
Each “Fund Type” is decomposed into subordinate “Suites”, which are sub-groups of “Funds” that are specified in Section 75.30.10 of SAAM
Chapter 75. Each “Suite” is decomposed into its constituent “Funds”, also specified in Section 75.30.10 of SAAM Chapter 75. Each “Fund”
can be further decomposed into “Sub-Funds”, as needed for agency management and reporting purposes.

Geography/
Location

PROPOSED C_OA_S'[IRUCTURAL ELEMENTS

I Expenditure

Organizatio Authority

—_——

SEGMENT (Parent Level)

SUB-SEGMENT (Fund Type Level 1)

GOVERNMENTAL
FUNDS

PROPRIETARY FIDUCIARY
FUNDS FUNDS

SUB-SEGMENT (Suite Level 2) Mandatory

Coding

2 Private- :
Special : : Internal Pension
Debt Service Permanent Enterprise 3 Purpose
Service Trust

Lree Funds H Funds Trust

Funds Funds Funds Funds

L | LR

General

Higher
Education
Facilities

State
Basic Administrative Other Facilities
Fund

SUB{SEGMENT (Sub-Fund Leve| 4+)

Optional
Coding
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Expenditure Authority Coding Elements
The structural element “Expenditure Authority” is decomposed into two “Appropriation Authorities” — “Appropriated” for spending
authorized by legislative appropriation act and “Non-Appropriated” for spending authorized outside of the legislative appropriation process.
Each “Appropriation Authority” is decomposed into “Spending Authorities” indicating its type of appropriation (for “Appropriated”
spending), or indicating its origin outside of the appropriation process (for “Non-Appropriated” spending). Each “Spending Authority” is
decomposed into its possible “Spending Sources”, including “State”, “Federal”, or “Private/Local” sources. Each “Spending Source” can be
decomposed further into “Budget Control” sub-components as needed for agency management and reporting purposes.

PROPOSED COA STRPC_TU_RA_Il. ELEMENTS

Geography/
Location

EXPENDITURE
AUTHORITY

SEGMENT (Parent Level)

SUB-SEGMENT (Appropriation Authority Level 1) l l

APPROPRIATED oM

APPROPRIATED

SUB-SEGMENT (Spending Authority Level 2)

l l l |____ Mandatory

Coding
Direct Back-of-Budget Unanticipated
Appropriations Appropriations Receipts
SUB—SEGIAENT (SpenTng Source Tvel 3) l l l
State Federal L) State Federal L) Federal L)
Local Local Local

SUB-SEG}AENT (Budg}t Control L%el 4+) l l l l l
Optional
Coding
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Account Coding Elements

At the highest level, the structural element “Account” is decomposed into five coding elements. “Assets”, “Liabilities”, and “Fund Balance
and Net Position” pertain to the state’s balance sheet. “Revenues” and “Expenses” pertain to the state’s operating statement. Balance sheet
coding elements, “Revenues” coding elements, and “Expenses” coding elements are presented in separate views on the next three pages.

PROPOSED COA STRUCTURAL ELEMENTS

I —-—
|
Expenditure I I Geography/
Authority I I Location
| |
I — T ——

SEGMENT (Parent Level)

SUB-SEGMENT (Account Level 1)

FUND

BALANCE REVENUES

LIABILITIES

AND NET
POSITION

(SOURCES)

SUB-SEGMIENT (Account Leyvel 2)

L

]

d

LG

SUB-SEGMENT (Account Level 3)

SUB-SEGMENT (Account Level 4+)
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The balance sheet coding elements at “Account” (Level 1) are decomposed into as many coding elements (Level 2 and lower) as needed to
enable efficient, straightforward development of the CAFR and other statewide financial and accounting reports through the use of “roll-up”

reporting tools.

PROPOSED COA STRUCT URALIELEMENTS

'

Geography/|
Location

SEGMENT (Parent Level)
ACCOUNT

(Balance Sheet View)

SUB-SEGMENT (Account Level 1) l

FUND
BALANCE
LU
POSITION

LIABILITIES

SUB-SEGMENT (Account Level 2)

Non-Capital

-Term Restricted

SUB-SEGMENT (Account Level 3)

e

Depreciable . Cash Investments
Depreciable

SUB-SEGMENT (Account|Level 4+)

Buildings and
Improvements,
Depreciation
Allowance, Etc.

Land,
Transportation
Infrastructure, Etc.

Cash in Bank, Investments,

Temporary/Pooled
Petty Cash, Etc. ‘l’:ashryE/tc.

REVENUES
(SOURCES)

Mandatory

Coding
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The “Revenues” coding element at “Account” (Level 1) is decomposed into the seven revenue sources (Level 2) specified in Section
75.80.20 of SAAM Chapter 75. Each revenue source (e.g., “Taxes”) is decomposed into its constituent components (Level 3) as listed in
Section 75.80.30 of Chapter 75. Each constituent component is decomposed into as many sub-components (Level 4) as needed for statewide
management and reporting purposes.

PROPOSED COA STRUCTURAL ELEMENTS

I —-—
|
|
Expenditure I . . Geography/
Authority I I SRS e Location
' |
T — — s —

SEGMENT (Parent Level)

SUB-SEGMENT (Account Level 1)

ACCOUNT

(Revenues View)

FUND
BALANCE

AND NET
POSITION

-

SUB-SEGMENT (Account Level 2)
SUB-SEGMENT (Account Level 3)

SUB-SEGMENT (Account Level 4+)

REVENUES
(SOURCES)

Licenses,
Permits
and Fees

Federal
Revenue

State
Charges

Private/
Local
Charges

Other

Revenues and

Financing
Sources

!

Liquor
Sales Tax

13.7% Licensee

Liquor Sales Tax,
20.5% Over-the-

Counter Liquor
Sales Tax, Etc.

L

Etc.

l

'

5!

5!

‘e

‘e

}

Mandatory
Coding

|____ Optional
Coding

19



ONE WASHINGTON — Washington Chart of Accounts Redesign Project
Final Chart of Accounts Design

The “Expenses” coding element at “Account” (Level 1) is decomposed into the 13 expense objects (Level 2) specified in Section 75.70.10
of SAAM Chapter 75. Each expense object (e.g., “Salaries and Wages”) is decomposed into its constituent components (Level 3) listed in
Section 75.70.10. Each constituent component is decomposed into as many sub-components (Level 4) as needed for statewide management
and reporting purposes.

PROPOSED COA STRUCTURAL ELEMENTS

I — —
|
|
Expenditure I . . Geography/
Authority I I SRS e Location
| |
e e e

SEGMENT (Parent Level)

ACCOUNT

(Expenses View)

SUB-SEGMENT (Account Level 1)

B

SUB-SEGMENT (Account Level 2)

FUND
BALANCE

REVENUES
(SOURCES)

Mandatory
Coding

AND NET
POSITION

Grants,
Benefits,
and Client Service
Services

Inter-Fund
Operating
Transfers

Other
Expenses

Salaries Capital

Outlays

and Wages Benefits

Contracts

SUB-SEGMENT (Account Level 3)

e

Classified Etc.

|____ Optional

N

Regular
Salaries,
shift
Differential,
Etc.

SUB-SEGMENT (Account Level 4+)
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Service Coding Elements

The structural element “Service” is decomposed into eleven “Service Types” that cover the broad categories of external and internal services
that state government delivers to citizens and stakeholders. Each “Service Type” is decomposed into subordinate “Suites”, which are MECE
sub-groupings of the services in each broad category. Each “Suite” is decomposed into the discrete “Services” it comprises. Each “Service”
can be decomposed further into “Sub-Services”, as needed for agency management and reporting purposes.

PROPOSED COA STRUCTURAL ELEMENTS

-
1
i | Geography/
Authority 1 Location
1
— |

SEGMENT (Parent Level)

SUB-SEGMENT iService Type Level 1)

HEALTH-

ENERGY AND JUDICIAL LABOR AND CENTRAL

PUBLIC
SAFETY

COVERAGE
SERVICES

ECONOMIC AND LEGAL WORKFORCE
DEVELOPMENT SERVICES DEVELOPMENT

TRANSPORTATION® AND PUBLIC B ADMINISTRATION
ENGAGEMENT 8 AND OPERATIONS

ENVIRONMENT

SUB-SEGMENT (Suite Level 2)

e =

Public
Employee
Health
Coverage Suite

SUB-SEGMENT (Service Level 3)

State
Employee
Health
Insurance

Etc.

SUBlSEGMENi(Sub-Service Level 4+)

Optional
Coding
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Project Coding Elements

The structural element “Project” is decomposed into “Project Types” that cover the broad categories of defined projects and grant-funded
efforts state government undertakes, which can span agencies and fiscal periods. Each “Project Type” is decomposed into subordinate
“Suites”, which are MECE sub-groupings of the projects and grant-funded efforts in each broad category. Each “Suite” is decomposed into
the discrete “Projects” it comprises. Each “Project” is decomposed into its constituent ‘“Phases”. Each “Phase” can be decomposed further
into its constituent “Tasks” and “Sub-Tasks”. Using the hierarchy of “Project” coding elements, agencies can code project and grant
transactions at the level of detail that best meets their business needs either in the statewide accounting system itself or in their own internal
systems (with summary interfaces to the statewide system as required).

PROPOSED COA STRUCTURAL ELEMENTS

Expenditure

Authority

SEGMENT (Parent Level)

SUB-SEGMENT (Project Type Level 1)

INFRASTRUCTURE I,':EF SHR&?EQ\'(\' TRANSPORTATION ENVIRONMENTAL
PROJECTS PROJECTS PROJECTS PROJECTS

SUB-SEGMENT (Suite Level 2)

Mandatory
l Coding
Infrastructure Infrastructure
Suite 1 Suite 2
SUB-SEGMENT (Project Level 3
| |
Project 1 Project 2 Etc.
SUB—SEGIﬁENT (S%b—Proi'ect Lelel a4+) l
Optional
Phasel Phase2 Etc. Coding
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Geography/Location Coding Elements

The structural element “Geography/Location” is decomposed into “County Groups”. Each “County Group” is decomposed into its
constituent “Counties”. Each “County” can be decomposed further into “Sub-County” units (e.g., incorporated areas, unincorporated areas,

cities, towns, postal zones, etc.) to as low a level of detail as needed for agency management and reporting purposes.

PROPOSED COA STRUCTURAL ELEMENTS

Expenditure,
Authority

SEGMENT (Parent Level)

GEOGRAPHY/
LOCATION

SUB-SEGMENT (County Group Level 1)

COUNTY
GROUP 1

COUNTY COUNTY COUNTY
GROUP 2 GROUP 3 GROUP 4

SUB-SEGMENT (County Level 2)

SUB-SEGMEILT (Sub-County Level 3)

SUB—SEGMETT (Sub-County Level 4+)

v v

Mandatory
Coding

Optional
Coding
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Outcome Coding Elements

The structural element “Outcome” is decomposed into nine “Priorities” on which state government generally focuses in serving citizens and
stakeholders. Each “Priority” is decomposed into “Initiative Groups”, which are MECE groupings of the defined “Initiatives” undertaken to
tackle the “Priority”. Each “Initiative Group” is decomposed into the specific “Initiatives” undertaken to achieve measurable goals related to
the “Priority”. Each “Initiative” can be decomposed into as many “Sub-Initiatives” as needed for agency management and reporting purposes.

PROPOSED COA STRUCTURAL ELEMENTS

Expenditure

Authority

SEGMENT (Parent Level)

SUB-SEGMENT (Priority Level 1)

VULNERABLE § ENVIRONMENT § CULTURAL AND

AND NATURAL B RECREATIONAL

PUBLIC EFFECTIVE AND

SAFETY

CHILDREN
AND ADULTS

EFFICIENT

RESOURCES OPPORTUNITIES® GOVERNMENT

SUB-SEGMENT (Initiative Group Level 2)

Pre-K
Initiatives

Secondary
Initiatives

SUB-SEGMENT|(Initiative Level 3)

Gl

Early
Preschool Learning
Enrolment Provider

Quality

Etc.

SUB-}EGMENi(Sub-Ini}iative Level 4+)

Mandatory
Coding

Optional
Coding
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6. Chart of Accounts Governance Model and Maintenance Process

Following the leading practice of centralized management and formal governance of the COA, the state
has defined a new governance model and associated maintenance process to be implemented along with
the new COA design. The governance model includes users and managers at different levels of both the
agencies and OFM who will participate in defining, reviewing and approving changes or additions to the
COA. The COA governance model and maintenance process are described below.

COA Governance Model
The governance model includes participants at four different levels, as shown below.

Chart of Accounts Governance Model

Oversight Reviews and approves/disapproves COA ~ Meets 3™ week of the month (or more often
Committee changes proposed by agencies. when needed).
Reviews COA changes proposed by = Reviews change requests as they are
agencies and makes recommendations to submitted and makes recommendations
Coordination Oversight Committee. to OC by 2™ week of the month.
Team = Implements approved COA changes by

end of the month.

Agency Evaluates and approves COA change As needed.
Financial requests proposed by agency users.

Management

e s Propose COA Changes. As needed.

Oversight Committee will include senior financial and accounting managers from a cross-section of
agencies and serve as the central reviewer and final approver of COA change requests originated by
agency users and vetted by the coordination team and senior agency financial managers. (An exception
to the committee’s approval role will be those situations in which OFM is required to give final
approval to certain COA changes by virtue of its statewide fiscal management responsibilities.)

Coordination Team will include COA subject matter experts at OFM who work regularly with
agencies proposing COA changes to ensure the requests are consistent and complete in all important
details and unresolvable through use of existing COA coding elements.

Agency Financial Management will include senior managers responsible for administering their
agencies’ internal COA change request vetting process and ensuring that approved requests submitted
by their agencies meet defined criteria for consideration by the oversight committee.

Agency Users normally will make the initial requests for COA changes when they identify apparent gaps
in the COA and determine that such gaps cannot be resolved through the use of existing coding elements.
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COA Maintenance Process
The maintenance process that participants in the governance model will follow includes four steps, as

depicted below.

Chart of Accounts Maintenance Process

Agency Coordination Oversight Change

Change Team Committee

Request Review Approval Implementation

At the start of the process, agency users normally will submit formal change requests to their
management teams to be evaluated for need and compliance with COA guidelines.

Agency Coordination Oversight
Change Team Committee
Request Review Approval

Change
Implementation

Agency Users Agency Financial Management

Initiate request

for change to or Evaluates change Forwards approved
creation of a request for need request to

coding element and compliance Coordination Team
and forward to with COA for review

agency financial guidelines

management

After change requests are approved and submitted by agency managers, the coordination team will
evaluate the requests for consistency, completeness and alternatives.

Agency Coordination Oversight
Change Team Committee
Request Review Approval

Change
Implementation

Coordination Team

Evaluates change If request meets need
request for need and standard and COA

compliance with COA guidelines, forwards to
guidelines Oversight Committee
for decision
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When a change request is forwarded to the oversight committee, the committee will review it and
determine whether to approve the request as submitted. If the committee approves the request, the
coordination team will advise the requesting agency accordingly.

Agency Coordination Oversight Change
Change Team Committee Implementation
Request Review Approval

Oversight Committee Coordination Team

If Approved by OC,
notifies agency and
OFM to proceed with
implementation

Reviews and approves
change request

(0] 33
If Disapproved by OC,
notifies agency giving
rationale and
recommended alternative

Reviews and disapproves
change request

Finally, the coordination team will implement the approved COA change, communicate the change to
all agencies and update the State Accounting Manual as needed.

Agency Coordination Oversight Chansge
Change Team Committee s :

X Implementation
Request Review Approval

Coordination Team

Implements If needed, provides
approved change input to update

and notifies State Accounting
requesting agency Manual to reflect
when done the change
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7. Expected Benefits of the Redesigned Chart of Accounts

The primary reason for redesigning the COA is to facilitate and support the compilation and analysis of
consistent and accurate financial information across state agencies. When fully implemented and
applied, the redesigned COA will help ensure that all state agencies’ financial results meet the same
high standard for accounting and reporting, and that they can be reliably compared to one another.

The redesigned COA also will reinforce Washington’s business transformation strategy and enhance
the state’s planning for its new ERP system. As part of the ERP system implementation, the redesigned
COA will help the state achieve its strategic objectives for business transformation, fiscal control,
financial analysis, and reporting and administrative operating efficiency. Specific benefits that will
support these objectives expected from full implementation of the redesigned COA are summarized in
the table below.

= Improved financial analysis that makes statewide financial information more
transparent, accurate, real-time, comparable and consistent.

Expedited Business = Increased visibility into operations and, when appropriate, support for the
Transformation integration of previously isolated functions.

= New opportunities to share and standardize leading accounting and reporting
practices and streamline administrative processes.

= Strengthened internal controls that are more automated and preventative and less
Enhanced Internal manual and retrospective.
Controls and
Greater Regulatory
Compliance

= More consistent data integrity as a result of centralized data control and reduced
reliance on spreadsheets and other “off-system” data sources.

= Lower audit costs.

= Improved reporting and tracking capabilities at all levels of state government.
Improved Financial
and Management
Reporting = Less complexity in reporting because all speak the same accounting language
across the enterprise.

= Enhanced analysis and comparability across business units and fiscal periods.

= Reduction of time and effort devoted to systemic data work-arounds currently in
use.
Increased Operating

. = More efficient accounting and reporting operations because of common data
Efficiency

definitions and sources.

= Elimination of duplicative reports and data mapping/translation tables.
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Appendix A — One Washington Operating Principles

One Washington Operating Principles for Serving the People of Washington

PURPOSE:

How does the organization
define its purpose?

ACCOUNTABILITY:

To whom is the organization
accountable?

INCENTIVES:

What matters and how are
they made to matter?

CONTROL:

What is controlled and by
whom?

CULTURE:

What are the unwritten
rules?

Do the right things right: Assume things are allowed unless they are explicitly
prohibited, and assume things can be questioned even if they are required.

Deliver outcomes for those we serve, anchored in our mission, vision, strategy
and values.

We are accountable to authorizers for what we do and to those we serve for
how and how well we do it.

Our performance story is told through the use of data and analytics.

Quality is defined by those we serve.

What matters are the outcomes we deliver and their quality (i.e., measured by
the experience, timeliness, price, ease, etc.), as defined by those we serve.

We recognize and reward quality outcomes and learning from our work based
on data and analytics.

Set performance targets and measure progress towards those targets.
Pursue customer feedback that is direct, immediate and personal.

We focus on assuring delivery of quality outcomes with authorized resources.
Compliance is achieved primarily by motivating people to act voluntarily.
Decisions are driven by data and analytics.

Control is delegated and supported.

Controls are risk-based.

We assume people will perform and empower them to take risks and succeed.

We combine data and analytics with flexibility and innovation to support
continuous improvement.

Ours is a service-oriented culture.

We tell our story and the stories of those we serve — they connect people to
what we do and why.

29



ONE WASHINGTON — Washington Chart of Accounts Redesign Project
Final Chart of Accounts Design

Appendix B — ERP Software Vendor Feedback on the Strawman Chart of Accounts Design

ERP Software
Solution

Solution COA’s
Alignment with
Strawman COA

Solution’s
Ability to
Define Data
Roll-Ups

Solution’s Tools
for Producing
CAFR and
Other Key
Reports

Other
Comments

Oracle PeopleSoft Version 9.2
Oracle ERP Cloud Release 11

Solution COA elements
completely configurable by
customers

Solution COA can support all

Strawman COA structural
elements

Customers can define roll-ups

for each Strawman COA
element
Multiple roll-ups can be

defined within each Strawman

element

Financial Reporting Studio
tool enables end-users to
produce complex financial
reports

ERP Cloud solution comes
with Oracle Transactional

Business Intelligence tool and

provides ad hoc/operational
reporting across all functions

ERP Cloud solution offers a
Project Portfolio Management

module for capital and non-capital

projects and grants

Workday Financials
Update 26

Strawman COA elements can be

supported by solution COA
elements with some
customization

Customers can define roll-
ups for each Strawman
element

Solution provides reporting
at hierarchy element level

Delivered reports/
dashboards and custom tool
enable end-users to compile
information and produce
reports

Solution integrates to third-
party applications to create
published reports (e.g.,
CAFR)

Solution provides the ability to
change names/labels of some
COA elements (e.g., Project)

SAP S/4AHANA

Strawman COA elements
can be supported by
solution COA elements
Vendor recommends
addition of Strawman
element for Grants to meet
donor/ sponsor transactional
and reporting requirements

Customers can define roll-
ups for each Strawman
element

Solution allows element
decomposition to lowest
level required and flexible
reporting

SAP Business Objects tool

Solution’s element names/
labels are fixed

CGI Advantage ERP
Version 3.11

Strawman elements can
be supported by solution
COA clements

Some solution COA
elements are centrally
defined while others are
department-defined

Most COA elements
have four roll-ups for
higher level groupings
of information

Fund and Object have
more than four roll-ups
for specific reporting

InfoAdvantage tool
produces the CAFR,
Budget Control and
Expenditure Analysis
Reports

CAFR Reporting
Module delivers nine
configurable reports

Solution’s element names
can be changed without
customization
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Appendix C — Utilizing the Redesigned Chart of Accounts Before ERP Implementation
An important goal of the COA Redesign Project is to establish a chart design that can provide business value for the State of Washington even

before it implements its new ERP system. To help the state determine how to use the new COA design most advantageously over the next three

to four years — until the new ERP system is operational — OFM considered and assessed nine options, including:

1. Do Nothing with New COA
Data Elements o

NO COA
CHANGE

2. Clean Up, Rationalize, and e
Make Consistent the
Current Elements of
Existing Charts

3. Implement Option 2 and
Pilot the New COA Design
at DSHS for Selected Uses

4. Implement Option 2 and
Incorporate Redesigned .
PARTIAL COA COA Elements That Will
IMPLEMENTATION Enable Consistent Capture
of Agency IT Costs

5. Implement Option 2 and
Incorporate Redesigned .
COA Elements That Will
Improve Federal
Compliance Reporting

6. Implement Option 2 and
Incorporate Redesigned .
COA Elements That Will
Enable Consistent Agency
Cost Allocation

7. Implement Option 2 and o
FULL COA Incorporate All Redesigned
IMPLEMENTATION  COA Elements

Put the new COA “on the shelf” until a new ERP solution is available
Require any statewide or agency system development involving financial data in the
“interim” period to be tested and approved by OFM for alignment with the new COA

Devote resources to changing the data (without changing the transaction processing
system) by cleaning up, rationalizing, and making consistent in the current AFRS (for all
agencies) and TRAINS (for DOT) COAs the 80% or more of elements they have in
common with the new COA

Do nothing with the ~20% of new elements in the AFRS and TRAINS COAs

Implement Option 2; and

Align DSHS’s current agency-COA project with the redesigned COA and implement the
new COA design for budgeting, accounting, and reporting at DSHS in FY17

Implement Option 2; and

Launch a project to enhance AFRS and modify according to the redesigned COA its chart
elements and data definitions involved in capturing IT costs

e Make AFRS the single source of agency IT cost data

Implement Option 2; and

Launch a project to enhance AFRS and modify according to the redesigned COA its chart
elements and data definitions required by selected agencies to create compliance reports
for Federal grants and other external funding sources

Implement Option 2; and

Launch a project to enhance AFRS and modify according to the redesigned COA its chart
elements and data definitions involved in the allocation of costs against programs,
projects, and activities by selected agencies

Implement Option 2; and

Launch a project to enhance the existing AFRS and TRAINS COAs so they include all of
the new elements from the redesigned COA to enable data capture and reporting using
these new elements
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8. Implement a Transaction e

TRANSACTION Reporting Solution Using
REPORTING AND the Redesigned COA

ANALYSIS
SOLUTION i
IMPLEMENTATION

BUDGETING/ 9. Implement a Statewide .

Budgeting System Using
PLANNING SYSTEM :
IMPLEMENTATION the Redesigned COA o

Enhance the current enterprise reporting solution and protocols such that current
transaction data is fed into the OFM data warehouse coded according to the redesigned
AFRS COA and “cleaned up” as described in Option #2

Create a new reporting system or protocol to capture new transaction data using the new
COA elements and feed this into the OFM data warehouse coded according to the
redesigned AFRS COA

Implement a statewide budgeting system that uses the redesigned COA and interfaces with
the AFRS COA (still using current data elements)

Integrate the new budgeting system into the full ERP system and complete the redesigned
COA later

(Note: The options summarized in the table above are based on the assumption that approximately 80% of the data elements in the current
COA will continue to be used, and 20% of the data elements in the redesigned COA will be new.)

In assessing the options for utilizing the redesigned COA before ERP implementation, OFM balanced each one’s expected business value
against the amount of resources, time, political capital, and funds that likely would be required to implement it. The options were grouped in

one of four categories, as shown below.

COA Utilization Option Assessment Framework

High

Expected
Business
Value

Low

Low

High Value/ High Value/
Low Effort High Effort
Low Value/ Low Value/
Low Effort High Effort
High
Relative

Level of Effort
to Implement
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Options assigned to the upper-left quadrant would be the most attractive to pursue before ERP system implementation. Options in the lower-
left and upper-right quadrants could be worth pursuing depending on how long the period before ERP implementation is expected to last.
Options in the lower-right quadrant likely would not be worth pursuing until the new ERP system is implemented.

Applying the above framework, OFM grouped the options for utilizing the redesigned COA as follows:

MOST DESIRABLE OPTIONS POTENTIAL LONG-TERM OPTIONS
High 2. Clean Up, Rationalize, and Make 3. Option 2 + Pilot New COA Design at DSHS
Current COA Consistent

Option 2 + Enable Consistent Capture of
Agency IT Costs

5. Option 2 + Improve Federal Compliance
Reporting for Agencies

6. Option 2 + Enable Consistent Agency Cost
Allocation for Agencies

7. Option 2 + Incorporate All Redesigned
COA Elements

8. Option 2 + Implement a New Transaction
Reporting Solution Using Redesigned COA

Expected 9. Option 2 + Implement a New Statewide
Business Budgeting System Using Redesigned COA
Value
POTENTIAL NEAR-TERM OPTIONS LEAST DESIRABLE OPTIONS

1. Do Nothing with New COA

Low

Relative .
Low Level of Effort High
to Implement
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As the relative ratings shown below indicate, Option 2 — “Clean Up, Rationalize, and Make Current COA Consistent” — was determined to

be the most desirable option to pursue immediately. Option 4 — “Enable Consistent Capture of Agency IT Costs” — would be good to pursue

once satisfactory progress is made on Option 2. After that, other options could be considered for implementation depending on when
implementation of the ERP system is scheduled to begin.

High MOST DESIRABLE POTENTIAL LONG-TERM RIS
OPTIONS OPTIONS 1. Do Nothing with New COA
2. Clean Up, Rationalize, and Make
Current COA Consistent
3. Option 2 + Pilot New COA Design
7 at DSHS
4. Option 2 + Enable Consistent
Capture of Agency IT Costs
9 5. Option 2 + Improve Federal
Expected 5 Compliance Reporting for Agencies
i 8
Business 2 4 3 6 6. Option 2 + Enable Consistent Cost
Value Allocation for Agencies
7. Option 2 + Incorporate All
POTENTIAL NEAR-TERM LEAST DESIRABLE Redesigned COA Elements
OPTIONS OPTIONS
8. Option 2 + Implement a New
Transaction Reporting Solution
Using Redesigned COA
9. Option 2 + Implement a New
Statewide Budgeting System
Using Redesigned COA
Low 1
Relative ]
Low Level of Effort High

to Implement
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